The Lens and Eye

Volume 39 Number 9

Calendar
May, 2004
4

PCR: 7:00 pm.

5

Print night: 7:30 pm.
Judge: Judith Goodman.
Hospitality: Joe Maris, Mike Cline and
Alex Guo.

12

Slide night: 7:30 pm.
Judge: Richard Rohlfing.
Hospitality: Cezary Raczko and
Jean Hansen.
Gallery: Jerry Raines.

13

Visual Design: 7:30 pm, Kent Mason’s.

17

Print Critique: 7:30 pm, Bresses.

18

Slide Critique: 7:30 pm, Kent Mason’s.

19

Board Meeting: 7:30 pm; Lee’s.

23

Field Trip: Big Meadows, VA.

26

Program: 7:30 pm, Gary Silverstein and
Dave Carter.
Hospitality: Chuck and Carol Lee.

June, 2004
1
21

PCR: 7:00.
Print/Slide Critique: 7:30, Bresses.

Competition Assignment:
Open
Any photograph taken on or after
June 1, 2002.
===================================

Reminders!
It’s membership renewal time.
The deadline for sending in your
membership renewal form is
July 15, 2004. The form can be
found on page 11 of this issue
and on the NBCC web site.
Also the Awards Dinner will be
held on June 2, 2004, 6:30 pm.
The Reservation form can be
found on page 13
May, 2004

North Bethesda Camera Club

http://nbccmd.tripod.com
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Judith Goodman Will Be
Our Print Night Judge

Richard Rohlfing To Be
Slide Night Judge

Judith Goodman is a fine art photographer and sculptor whose
work has been exhibited nationally.

We are happy to welcome Richard and Ann Rohlfing back to
North Bethesda to judge our May
slide competition. Members of the
Bowie-Crofton Camera Club, the
Rohlfings have been involved
with photography for a number of
years in both the commercial and
teaching fields. They have presented programs to camera clubs
and civic groups on a variety of
subjects, and have taught classes
and workshops on general photography, large format, close-up,
travel and portraiture.

She also works as a commercial
photographer with her husband
and partner Frank Van Riper in
the Washington-based Goodman/Van Riper Photography.
Judith’s photographic work has
hung in the Corcoran Gallery of
Art, the Baltimore Museum and
the Tisch Gallery at NYU. She
and her husband currently are
working on a joint photography
book project, Serenissima: Venice in Winter. Work from that project will be shown in September
at the Robert Rentz Gallery in
Richmond, Va.
Goodman’s fine art studies began
at the Corcoran School of Art and
continued at the Maine Photographic Workshops where she
undertook master class study
with Arnold Newman, Olivia Parker, Lilo Raymond and Christopher James.
A member of the Washington
Sculptors’ Group, Judith has exhibited her sculpture around the
country. One of her sculptures,
“Sanctuary,” may be seen in the
current WSG show at Washington Square in downtown DC at
Connecticut Ave. and L Street.
Jim Hawkins

Operating a 17-year photography
business
under
the
name
R.A.R.E. Photographic (Richard
and Ann Rohlfing Enterprise)
their clients have ranged from a
manufacturer of underwater robotic machinery to a restorer of carousel horses.
To document a unique Maryland
tradition of quilting Richard and
Ann photographed 160 quilts with
a 4 x 5 camera using transparency film, setting up a portable
studio in six different areas of the
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In Memory of Joe Razza
This issue of The Lens
and Eye is dedicated
to the memory of Joe
Razza, one of NBCC’s
most involved, well
known, and beloved
members, who died on
April 8, 2004
Joe began his life
sharing the notoriety of
a famous day in United
States history. Joe was
born in Brooklyn, New
York, on October 29th,
1929, also known as
Black Tuesday, the start of the Great Depression.
It is reported his mother said “When Joe was born
the bottom dropped out.” Some say Joe’s birth
balanced the bad news of the stock market crash.
Joe showed an early interest in photography when
he borrowed his father’s Brownie camera to use in
high school journalism and photography courses
where he learned about darkroom and enlarging
techniques. Joe apparently was a good student as
is shown by his long litany of quality photographic
work throughout his life.
Joe was ordained as a priest in his early years, but
soon left the priesthood. He left his New York Park
Slope neighborhood to attend Catholic University
as a philosophy major, but also took courses in
journalism. Upon graduation he then worked for
the National Association of Life Underwriters as a
writer, editor and photographer. In this job, Joe
interviewed insurance agents, followed pertinent
legislation and wrote articles about underwriters
making news in the industry. His natural ability to
take quality portraits added to the articles he wrote.
He also was dispatched to conventions where he
captured the proceedings both editorially and
photographically. He did extensive traveling performing this job and retired in 1994 as editor and
photographer. Joe was an avid reader and student
of photography. If you wanted to know about some
photographer, Joe usually could tell you all about
him/her and their works.
Joe joined NBCC in the early 90’s and immediately
joined the Lens and Eye team. He must have
quickly impressed people since he served as
President shortly thereafter for two terms, 1994 –
1995. He then served on a multitude of committees
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including Field Trip Chairman, Workshop
Chairman, Outreach Chairman and Director. Joe’s
wry wit and awful puns made him a joy to be
around. Joe also volunteered for many special
purpose groups such as the Executive Board
nominating committee, the assignments committee, review of rules, clarification of rules, recording
winners of print competitions and many, many
more. He also shared his experience by teaching
photography classes to high school students and
senior citizens in Rockville.
One of Joe’s most important projects was as the
leader of the Phabulous Photographers, a camera
club outreach program sponsored by Potomac
Community Resources to teach photography to
people with developmental disorders. Joe was the
inspiration for the monthly gathering where PCR
members presented and displayed their photos
and NBCC members provided reviews and helpful
hints. Joe’s expertise and wry wit provided the
foundation for his presentations whether he was
explaining the next month’s assignment or providing tutorials on photographic topics. Joe received
the Priscilla Sullivan award for volunteer community service, presented by County Executive Doug
Duncan, for his work with the Phabulous Photographers.
On Tuesday, April 13, a crowded memorial service
was held at the Bradley Hills Presbyterian Church
to celebrate his life. A succession of speakers including friends, business associates, camera club
members and family, recalled his good deeds, his
good humor and his plain goodness.
In closing let us fondly remember his most famous
quote which was his opening salutation in his
phone calls: “Razza here,…What’s happennin’?” I
am also reminded of a quote by Albert Pike: What
we have done for ourselves alone dies with us;
what we have done for others remains and is
immortal. Joe certainly left a lot for us.
Joseph C. Razza 1929 – 2004
Joe is survived by a son, Joseph C. Razza, III, two
daughters, Renata Razza and Connie Razza and a
sister, Jean Moore. He is also survived by his long
time companion, Audrey Beck. Joe’s family and his
Camera Club friends will miss him very much.
Donations can be made in Joe’s name to the
Potomac Community Resources, 9200 Kentsdale
Drive, Potomac, MD, 20854.
Text by Tom Sullivan; Photo by Joel Hoffman
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Richard Rohlfing (continued from p.1)
state in order to photograph quilts from each area.
The result of this effort is a large coffee table type
book entitled A Maryland Album chronicling
Maryland history from 1634 to 1934 through its
family quilts.
The Rohlfings use Nikon equipment, and after years
in the chemical darkroom they have moved into the
digital environment. Ann uses a Nikon D100 while
Richard is shooting with a Nikon Coolpix 5700. He
especially enjoys architectural subjects, portraiture,
and macro photography, while Ann prefers
landscape, nature and flowers for her subjects.
We look forward to having the Rohlfings with us in
May to critique our members’ work and help us
improve our skills as photographers.
Barbara DeLouise

NBCC Prepares for Next Year
As we approach the end of the current Club year
(our 39th), it’s important that we take time to reflect
on what we are doing as a group and to begin our
planning for next year and beyond. NBCC, like
many other camera clubs, is in a transitional phase.
The new and developing digital technology is steadily driving changes in the world of photography.
Most if not all of us would agree that we have been
affected in some way by these changes. What
impact will they have in the future, not only on us as
individuals but also on our Club? . . . in five years? .
. . ten years? Can anyone really say?
As you know, NBCC has already modified its competition rules to better accommodate digital processes, particularly with regard to prints. Recently we
have begun to see digitally manipulated images
entered in slide competition. Does this mean that
NBCC should create a separate competition category for “Altered Slides” much the same as we have
done for “Altered Prints?” Or, should NBCC prohibit
digitally enhanced imagery from being entered in
slide competition at all, maintaining traditional
“purity” of this category? Or, should we simply leave
the rules as they are for the time being? Do you
have an opinion? These and other issues seem best
re-solved through the collective wisdom of our many
talented members with their diverse interests and
perspectives. You are encouraged to express your
views in writing to officers and Board members of
the Club.
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A year ago, NBCC’s Board modified the Club’s
monthly meeting format, acting with the benefit of
considerable input provided by the membership.
This past year may not have been a good test of
those adjustments, due to several meeting date
conflicts with the Church’s schedule as well as a
couple wintry weather cancellations – thus, we were
short-changed on educational opportunities associated with our Program Nights. Nonetheless, you
may have suggestions that you would like to make
about how the Club’s meeting format or related
activities might be improved. You will be given an
opportunity to communicate your ideas as part of
the application form that all of us are asked to
complete annually to renew our NBCC membership
for next year. Meanwhile, please feel free to pass
along your ideas in writing at any time, especially
right now. You can email your thoughts to
bobpeavy@comcast.net or, as noted, contact any
Board member. (We prefer written comments as
these can be shared more easily among relevant
committees and the Board.)
This is also a good time to consider whether you
could take an active role on one of the Club’s
committees for next year -- an excellent way in
which to become better acquainted with other Club
members and to be involved in NBCC’s evolution.
Committees are the engine that moves the Club
forward. We need lots of help from members. Committees for the 2004-05 season will soon be formed
and some, like the Program Committee, will begin
their work over the Summer to prepare for our initial
meetings in the Fall. Spreading the Club’s tasks
among many helps to ease the burdens on each.
We hope you’ll be able to contribute, regardless of
whether you have any comments at this time.
Bob Peavy, NBCC President
======================================================

Save the Date
NBCC Annual Picnic
August 15, 2004
At Anita van Rooy’s House
Details in the Summer Lens and Eye,
scheduled to be published in late June.
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Retro Fill Flash (Expert’s Corner)
It happens often, especially if you allow yourself to
take a photograph in sunlight; shadow areas tend
to lack detail and lighter areas tend to be blown out.
A word of warning, shadow detail is more easily
recovered by digital fill flash than recovery of lost
detail in the highlights. To avoid this you should err
on the side of underexposure. Given that caveat,
how do we best enhance detail in the shadow
areas? The idea is simply that we want to adjust
the exposure levels in the shadow zones. There are
several ways to recover detail exclusively in the
shadows.
A plausible sounding approach is to use Photoshop
Elements with its Fill Flash feature. However, you
will soon learn that Fill Flash alone is quick to lose
detail, especially in the highlights. Applying Fill
Flash to the entire image, or even to isolated
shadow areas, is a mistake. And, it is not at all
obvious how to select the shadow areas.
Remember what experts say is the only good way
to use Brightness/Contrast? “Immediately after
opening - click the Cancel button.” The same goes
for Fill Flash – don’t use it. Why? Fill Flash provides
only brightness and saturation control. Boosted
brightness would need to be offset by added
contrast and that is not available, and even if it
were, it would not be an optimal approach.
Back to the first paragraph, “how do we best
enhance detail in the shadow areas?” Think of it
this way: if you have a landscape with shadow
detail that you would like to enhance and a nice sky
with clouds, you need to be able to adjust the
shadow areas while making no change in the
highlight areas.
A powerful approach is to define the problem with
reference to the image histogram. This is a clever
little graph that provides a summary picture of the
distribution of pixel (light) values in an image. If you
are not familiar with histogram you are missing
something. To get on top of it, try filling an empty
(white) image window with black and white
gradients while varying the opacity. After each trial,
call up a Levels histogram (Ctrl L) and, when
finished, Cancel. Note that digital cameras can also
provide histograms. Understanding the histogram
helps you to evaluate your light settings and to
critique the light values in a digital image file before
(and after) you make any adjustments.
From left to right along the histogram horizontal
axis are shown the number of pixels at each value
level from shadow to mid-tone to highlights on a
May, 2004

scale from 0 to 255. This is one reason why image
adjustments are best begun with Levels - because
it provides a companion histogram. (Notice that the
Levels histogram is not affected by your use of
Levels. To see the histogram change after a Levels
adjustment you have to close Levels and then open
it again.) To enhance shadow detail, we must
select and thus isolate the image values on the
shadow side of the histogram, meaning the range
from black to middle gray. The selective isolation of
shadow values makes it possible to make
adjustments to the shadows without changing the
highlights.
There are several ways to select a range of shadow
values. The easiest way in Photoshop is to use
Color Range where you can Select for Shadows,
Mid-tones and Highlights. These categories divide
the histogram into thirds. (Got that? - think about it.)
Here is the one approach: First, set Color Range to
Select > Shadows. When you “Okay” this, the
shadows will be selected. Next, by calling up a
Levels adjustment layer, you can adjust only the
shadow tones. Notice in the Levels Layer palette
that a mask on the right accompanies the levels
icon on the left (a small histogram). The dark areas
in the mask attenuate the Levels adjustment, while
the light areas allow it. Grey areas mean partial.
When you are finished with this, you can deselect
and use a Curves Layer for a final overall tweaking.
I prefer to work a little more broadly in the lower
half rather than the lower third of the histogram.
The following is an adaptation of a procedure you
can find on the web by looking for “Photoshop
Claw.” Here it is:
Q (quick mask)
Ctrl – Alt – ~ (tilde)
Shift – Ctrl – I (inverse select)
Ctrl I (invert)
Layer > New Adjustment Layer> Levels
Q (exits quick mask)
Ctrl D (Deselect)
This procedure selects a range from darkest shadows to middle tones. Your next step is to apply the
Levels correction with the Levels layer; it opens by
double clicking on the Levels icon you have just
placed on the Layers palette.
What does “Ctrl-Alt-tilde” do? I have yet to see a
good explanation. But the proof is in the pudding.
Look at the Levels histogram – does it represent
the shadows? Yes, it does, and it uses quick mask
to make that happen.
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A second approach can be made with both
Photoshop and with Photoshop Elements where
similar tonal selections are possible. Here’s how.
Open your image and make a copy layer with Layer
> New > Layer by Copy. Bring up the
Hue/Saturation adjustment palette and reduce the
copy layer’s Saturation to -100 to completely desaturate this layer. Click OK.
Now, using the Magic Wand, select the shadow
areas by clicking in a middle to dark gray area
using a wand tolerance between 50 and 64. The
Contiguous box should not be selected. You can
gage your selection by calling up a Levels palette
(Ctrl L) and inspecting the Histogram. Make a note
of the range of dark values selected and then click
Cancel. Try different tolerances or clicking locations
until the Histogram shows that only from near black
(far left) to near middle-gray (center) tones have
been selected. This is a hit or miss approach that
you can do more precisely as follows. Open the
Info palette with the options set to provide HSB
readings. Then, move the Magic Wand and do not
click until you find quartertones indicated by a
brightness (%B) of about 25%. Keep that selection
and delete the desaturated layer. The selection
shadows are now referred to your original
background layer. At this point you may feather
your selection by 5 or 6 pixels.
Now, open an Adjustment Layer with Levels and
move the white and middle sliders until the tonal
balance appears to be correct. This should improve
the detail in the shadow areas without washing out
highlights. As an optional last step, you can try for
an overall correction with Levels, or Curves (Photoshop only) to see if that would provide any
improvement.

Night Photography for Program Night
Gary Silverstein and Dave Carter have both had an
interest in night photography for many years. The
reason is simple. The light at night seems to give
magical qualities to otherwise ordinary scenes.
Their show includes a discussion of the many techniques useful in night photography as well as many
examples of how to find interesting subject matter.
Gary has been taking night photographs for many
years. His favorite subjects include old houses,
street scenes, people, cityscapes, and fireworks.
Gary works as a research analyst for Westat, a
social science research firm in Rockville. He also
operates Night Visions, a photographic business
that specializes in night photography.
Dave is an associate professor of psychology at
Georgetown University where he teaches, among
other things, a course called Psychology, Photography, and the Visual Arts. He is a former president of the Northern Virginia Photographic Society. He also edited Fotofax, the monthly NVPS
newsletter.
Gary and Dave have, over the past several years,
run a night photography workshop for their camera
club. The workshop included several field trips each
year, sessions devoted to discussing technique,
and critique sessions. We look forward to having
them here at NBCC.
Carol Lee
=====================================================

Which is the best approach? The answer depends on the picture. It is not difficult to invent
other approaches. For example, you can adjust
the shadow areas after selecting them with the
magic wand, then feather and simply use
Levels. Let me leave you with a challenge: what
do you think might be done to correct tonality
exclusively in clouds or other high-lights? Tell
me in an email. Or send me an email with
comments on this article. I welcome your
feedback!
Dave Freeman
=====================================================

Renew
Your
Membership
May, 2004

Memorial Day - May 31, 2004
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May Field Trip: Whitetail Deer Fawns at
Big Meadows in Shenandoah National Park
On Sunday 23rd of May we’ll meet in the Big Meadows
area of Shenandoah National Park in Virginia to
photograph whitetail deer fawns.
The Big Meadows area is located at mile 51 on Skyline
Drive, a leisurely 20 mile drive south from the Thornton
Gap Entrance Station. The area contains the Byrd Visitor
Center, gift shop, camp store, restaurant and gas
station. A mile north is the Big Meadows Lodge and
Campground.
The meadow itself is one of the best places in the park
to photograph whitetail deer and late May is the perfect
time to photograph fawns. The fawns are spotted and
can walk within a few hours of birth, but they will spend a
lot of their time hidden in tall grasses or brush, waiting
silently and still for their mother to return and feed them.
The young blend in well with most surroundings because
their coats are speckled with white. The best times to
find and photograph them, as with most wildlife, are
early in the morning and late in the afternoon. In the
meadow area, Skyline Drive runs east to west. For best
results start your walk from the east end of the meadow
in the morning and from the west end in the afternoon.
You’re most likely to see deer if you follow the tree line
on your walk. To get frame filling shots you’ll need a
telephoto lens in the 200mm+ range.

The format of the field trip is very open. You may choose
to arrive and leave on the same day, spend the night or
even make it into a two-night weekend getaway as the
writer has. If you choose to make it into an overnight trip,
the Big Meadows Lodge (800)-999-4714 is the most
convenient place to stay. At the time of writing it still has
more than 40 rooms available starting at $82 + tax. We’ll
meet at the Wayside Restaurant next to the Byrd Visitor
Center for a late lunch at 2pm on Sunday.
A few words about safety. Even though deer in the Big
Meadows area are habituated to people they are still
wild and unpredictable animals so keep your distance.
Where there are deer there are ticks so wear long pants
and periodically check yourself for hitch-hikers. Be
aware also that Shenandoah National Park has the
highest concentration of black bears in North America.
While you’re unlikely to run into one, stay alert at all
times. Depending on the weather in the days leading up
to the field trip, parts of the meadow may be underwater,
don’t try to cross it, it may cover a much larger area than
is immediately apparent. Standing water also attracts
mosquitoes so bring and apply insect repellent. Finally,
don’t forget sunscreen and plenty of film.
Useful links:

Shenandoah is also known for its waterfalls which can
be spectacular in spring and two of the most accessible
are in the Big Meadows area. Dark Hollow Falls at Mile
50.7, just east of Big Meadows, are 70ft high and a 1.4m
roundtrip hike from the parking lot. The trail is moderate
(440ft elevation change) but even if you don’t make it all
the way down you may find ample photographic
opportunities along the stream the trail follows for most
of its length. Just west of Big Meadows are Lewis Falls
at mile 51.4, 81ft high and a moderate 2.0m roundtrip
(795ft elevation change).
Sunset spots in the area include the Blackrock area, a
short walk from the south end of the Big Meadows
Lodge parking lot and Naked Creek Overlook at
approximately mile 53. Fog, very common in spring, can
make any one of the overlooks along the drive into a
great sunrise or sunset location.
May, 2004

http://www.nps.gov/shen/index.htm (official park information)
http://www.nps.gov/shen/pphtml/maps.html (various maps )
http://www.americanparknetwork.com/parkinfo/content.asp?cat
id=69&contenttypeid=33
http://www.visitshenandoah.com (general park information

and lodging info)
If you have any questions or need directions feel free to
contact me by phone on (202) 494-9713 or by email at
cezary@crphotography.net.
Cezary Raczko
=====================================================

Brookside Gardens is offering photographers special access to their Butterfly Show on selected days
from 8-10:00 AM, before the doors are opened to
the public. Normally tripods are not allowed or highly discouraged, but for these occasions they will be
allowed. There is a $20 charge for each day. The
dates are: May 22, June 26, July 24, August 28,
and September 11, 2004
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Member Comings and Goings
Lees win awards.
Both Carol and Chuck Lee won awards in a juried
competition sponsored by the Chevy Chase Womens Club. Carol won a first place with one of her
colorful canyon images, and Chuck won honorable
mentions for two black and white images.
=====================================================

New Business by Former Members
Two former NBCC members, Haley Pepper and Mauricio Fonseca, have started a new business, Rainforest
Adventure Center Expeditions. There are two components to the company. First they run trips to Costa Rica
for school groups, cooperative groups, families, and
photographers. The second part of the company is to
offer trips in the US (Costa Rica and Panama) on sail
and power boats. They are arranging trips for
photography clubs, groups and individuals to sail and
live aboard a boat. Some recommended locations
include the Intercostal Waterway, Chesapeake Bay and
Erie Canal. Living aboard a chartered boat provides a
unique sense of community and opportunity for the
sharing of ideas. More information can be found at:
www.rainforestadventurecenter.com
=====================================================

Invitation to IPS/IMF Exhibit
The International Photographic Society of the IMF
and World Bank has cordially invited the members
of the North Bethesda Camera Club to attend the
opening reception of its juried 34th Annual Photographic Exhibition. The reception will take place
on Monday, May 3, from 6:00 to 8:00 pm in the
Gallery of the International Monetary Fund, located
at 700 19th Street, NW, Washington, D.C.
For security reasons, a photo ID will be required to
enter the IMF building, and your name must appear
on the guest list at the security desk. Thus, if you
plan to attend, please contact Bob Peavy by Friday,
April 30 (301-986-8778, or bobpeavy@comcast.net)
so that your name may be included on the guest
list.

Photographic Society, including Jose Cartas who is
currently its president. Those of us who have
attended the annual reception in the past can attest
that the exhibit is inspirational, impressive and very
enjoyable. Hope to see you there.
Bob Peavy
=====================================================

Course in Contemplative Photography
As Monty Python would say: “And now for something
completely different”.
The Shalem Institute and Shambhala Meditation Center
of Washington, DC are co-sponsoring Contemplative
Photography A Workshop in Creative Seeing. In this
course, the camera is used as a tool to synchronize the
eye and mind. When eye and mind are in the same
place, your perception becomes clear and the world
more vivid. Through talks and hands-on exercises (with
and without the camera), you will become familiar with
the elements of vision: color, light and form, and texture,
lines and patterns. You will also learn to recognize the
"flash of perception"-where the ordinary magic of the
phenomenal world is revealed and can be captured on
film. Each day will end with a slide review of that day's
work.
The workshop dates are as follows: Introduction and
Slide Show: Friday, May 28, 8:00-9:30 pm at the Shambhala Center 8719 Colesville Road, Suite 210, Silver
Spring, Maryland Workshop: Saturday-Sunday, May 2930, 8:30 am -5:00 pm at the Shalem Institute 5430
Grosvenor Lane, Suite 100, Bethesda, MD (301-8977334). For more information their web site is:
http://www.shalem.org/progs.html#photog
The fee for the course is $120 (does not include film or
processing). Friday night talk is open to the public, no
charge.
Evelyn Jacob
=====================================================

Address Update:
Caroline Helou
4620 North Park Avenue, #1205W
Chevy Chase, MD, 20815-4596

Parking is not available in the IMF building itself,
and is scarce in the area around the building,
though after 6:00 pm it should be easier to find a
parking space on nearby streets or in parking
garages. Metro is an option – the IMF building is a
moderate walk from Farragut North or West
(depending on the red vs. blue line, etc.)
As many of you know, several NBCC members are
also prominent members of the International

May, 2004
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Exhibits
Exhibit by the Hammacks
James Hammack and Janet Myder Hammack
invite you to their Photography Exhibit at the
Kensington Row Bookshop. The bookshop is
located along “Antiques Row” at 3786 Howard
Ave. in Kensington, Maryland, one block east
of Connecticut Ave.

The shop’s two floors house used, rare and out-ofprint books. Our nearly 60 photos are displayed
throughout the shop on both levels. Happy hunting.
Hours are 10-6 Mon.-Sat. and 12-5 Sunday. The
shop’s phone number is 301 949 9416. The exhibit
runs from April 1 to May 31.
======================================================

Ansel Adams On-Line Exhibit
In 1943, Ansel Adams (1902-1984), America's bestknown photographer, documented the Manzanar
War Relocation Center in California and the
Japanese Americans interned there during World
War II. In "Suffering under a Great Injustice": Ansel
Adams's Photographs of Japanese-American
Internment at Manzanar, the Prints and
Photographs Division at the Library of Congress
presents for the first time side-by-side digital scans
of both Adams's 242 original negatives and his 209
photographic prints, allowing viewers to see his
darkroom technique and in particular how he
cropped his prints.
Adams's Manzanar work is a departure from his
signature style of landscape photography. Although
a majority of the photographs are portraits, the
images also include views of daily life, agricultural
scenes, and sports and leisure activities. When he
offered the collection to the Library in 1965, Adams
wrote, "The purpose of my work was to show how
these people, suffering under a great injustice, and
loss of property, businesses and professions, had
overcome the sense of defeat and despair [sic] by
building for themselves a vital community in an arid
(but magnificent) environment. . . . All in all, I think
this Manzanar Collection is an important historical
document, and I trust it can be put to good use."
Additional information can be found at:

Recent Photos of Duncan Whitaker

http://lcweb2.loc.gov/ammem/aamhtml/aamhome.html

An exhibit of Duncan Whitaker’s recent photos,
Down East, Photographs of the Maine Scene, is
being shown at the Creative Partners Gallery, 4600
East West Highway, Bethesda, MD, 20814, 301951-9441. Duncan’s intimate images capture the
essence of the Maine scene with simplicity and
clarity, be it the coastal waters, harbors, working
boats or lobster pots. They offer the viewer a fresh
and different way of seeing the familiar.

Shankman Annual Open House

The exhibit will run from May 4, through May 29,
2004. A reception will be held on Friday, May 14,
from 6:00 - 9:00 pm. Additional information can be
obtained from the Creative Partners web site at:
http://www.creativepartnersart.com/ ;
or Duncan’s web site at:
http://www.whitakerphotography.com/.

======================================================

Spring is finally here and Bert Shankman is having
his annual Spring Open House on Sunday, May 2,
2004, 12 – 6 pm. The show is titled “Old Roses…
Re-Created”. Bert grows almost all of the flowers
which he photographs. Last fall he and his wife
planted over 1,000 new bulbs and many will be in
bloom in time for the Open House. Bert’s address is:
3609 Patrick Henry Drive, Olney, MD, 301-7740655.
In his new studio you will be able to see how he
prints his pictures using the latest giclee technology.
As always though, his images are about feelings.
The technology is a means to an end. For more
information visit his website at:
www.photo-secession.com .
======================================================

Remember to Renew
Your Membership by July 15
May, 2004

Awards Dinner – June 2, 2004
6:30 PM
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Results of Competition for April 2004 – Nature in the Wild
Prints

Slides

Judge: Tomothy Edberg

Judge: Middleton Evans

Black and White, Novice – 4 entries
Tatiana Watson

Lady duck

Black and White, Advanced - 15 entries
st

1
2nd
rd
3
HM
HM

Sue Oberthaler
Bob Peavy
Chuck Lee
Chuck Bress
Chuck Bress

Roots
Lift off
Turret Arch
Choptank shadow
Swan and branches

Color, Novice – 17 entries
st

1
2nd
rd
3
HM
HM

Tatiana Watson
Bill Richards
Luis Bustillos
Louise Roy
Ann Jorgensen

Divine imperfections
Chaffinch in rain
Mantis
Sligo Creek water reflections
Standing still

Color, Advanced - 39 entries
st

1
2nd
rd
3
HM
HM
HM
HM
HM
HM
HM

Carol Lee
Carl Root
Dan McDermott
Anita Van Rooy
Bob Peavy
Laura Winslow
Carol Lee
Carol Lee
Cynthia Keith
Cezary Raczko

Mesa sunrise
Brookside profile
My dear little fawn
Look out
Mom and youngster
Dolphin dawn
Indian paintbrush
Antelope Canyon sunrise
I came to cast fire
Mirage

Altered – 10 entries
st

1
nd
2
3rd

Gordie Corbin
Marianne Davis
Gordie Corbin

Smokey Mountain tree
Squiggles 2
Smokey Mountain sunrise

=====================================================

National Geographic Culture Shock Week:
Explore National Geographic’s Culture Shock Week
Photo Gallery and Contest, photos from around the
world showing unusual life styles of dynamic and
infinite cultures at:
http://click.nationalgeographic.emailpublisher.com/maab9dyaa56kracB9xlbeKRPKM/

Also, a week full of special shows on the National
Geographic channel from April 19 to 23 at 9 p.m.
Each night beginning at 9 p.m. ET/PT, step outside
your world and experience some of the world’s
most fascinating cultures. From ancient customs to
forbidden rituals, dare to explore humanity like
never before with five nights of eye-opening
documentaries. What is shocking to you is a normal
way of life for others.

May, 2004

Novice – 33 entries
st

1
nd
2
3rd
HM
HM
HM
HM
HM
HM
HM

Ken Briefel
Mike Cline
Ann Jorgensen
Mike Cline
Barbara Mazurkiewitcz
Jack Mazurkiewitcz
Jack Mazurkiewitcz
Bill Richards
Bob Dargel
Barbara DeLouise

Dragonfly
Wallflower
West Virginia spring
Mono Lake swift
Fragile grace
Natural bricks
Elephant Rock
Little River reflection #2
Natural model
Doe cleaning baby deer

Advanced - 60 entries
st

1
nd
2
3rd
HM
HM
HM
HM
HM
HM
HM

Miranda Chin
Tom Sullivan
Anita van Rooy
Anita van Rooy
Cezary Raczko
Laura Winslow
Dan McDermott
Carol Lee
Mark Segal
Kent Mason

Mesa Arch
Hand in the sand
Mongoose family
Last rays
Moose
Triplets
Dearly beloved
Firelight
Marscape
Raindrops on maple leaf

=====================================================

Did you Know?
1: To change the SIZE of the paintbrush, pencil
or clone stamp , even the eraser and history
brush, hold the Left Bracket Key to decrease
the size and the Right Bracket Key to increase
the size. To change the SOFTNESS of the
brush shift - left bracket makes it softer and
shift - right bracket makes it harder.
2: To find the exact center of a layer choose
View>Show Rulers and then use the Free
Transform Command( Control T). You can now
drag the guides out of the Rulers and they will
snap to the grabber handles of the center
point.
Then don't forget to hit the Esc. key to get rid of
the Free transform. If you only have a background layer you must copy this first ( always a
good idea)
Anita van Rooy
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Cumulative Scores for 2003 - 2004
Black and White Prints

Color Prints

Novice

Novice

47
19
10
10
8

Will Grupenhoff
John Grupenhoff
Roy Sewall
Ken Briefel
Roger Langsdorf
Advanced

76
63
49
26
20
16
15
14

Sue Oberthaler
Chuck Bress
Pat Bress
Lee Goodwin
Chuck Lee
Marianne Davis
Carl Root
Bob Peavy

Altered Prints
79
60
33
27
22
16
6

Gordie Corbin
Anita van Rooy
Tatiana Watson
Jim Hawkins
Carol Lee
Bev Gordon
John Grupenhoff

97
58
42
26
20
20
10
6
6
6
6
6
6

Bill Richards
Barbara DeLouise
Tatiana Watson
John Grupenhoff
Richard Huang
Will Grupenhoff
Marcia Loeb
Bob Dargel
Ken Briefel
Len Friedman
Louise Roy
Alex Guo
Jesse Oroshnik
Advanced

88
79
45
39
38
22
20
18
18
14
12
12
6
6
6

Marianne Davis
Carl Root
Carol Lee
Anita van Rooy
Gordie Corbin
Jim Hawkins
Ross Pierce
Les Trachtman
Cynthia Keith
Joe Razza
Bob Peavy
Pat Bress
Roy Sewall
Dan McDermott
Laura Winslow

Novice Slides
74
64
64
41
32
30
28
24
23
20
18
15
14
12
10
9
8
6
6
6
6
6
6

Bill Richards
Mike Cline
Barbara DeLouise
Les Trachtman
Jean Hansen
Sue Milestone
Ken Briefel
Shereen Kopp
Alex Guo
Will Grupenhoff
Barbara Mazurkiewicz
Bob Dargel
Ann Jorgensen
Jack Mazurkiewicz
Louise Roy
Jin Gong
Larry Berlin
John Grupenhoff
Karen Coates
Marcia Loeb
Luis Bustillos
Stu Mathison

Advanced Slides
66
54
49
49
40
38
33
26
22
18
15
15
14
14
12
12
12
12
9
6
6
6
6
6

Carol Lee
Miranda Chin
Bob Peavy
Caroline Helou
Anita van Rooy
Carl Root
Tom Sullivan
Chuck Bress
Lester LaForce
Pat Bress
Kent Mason
Jim Hammack
Janet Hammack
Gordie Corbin
José Cartas
Ross Emerson
Jim Hawkins
Laura Winslow
Joel Hoffman
Cezary Raczko
Dan McDermott
Susan Helzer
Judy Switt
Sigrid Vollerthun

====================================================================================================

For Sale:

Brookside Gardens Field Trip

Brand new never used 10 x 24 ft gorgeous deep green & brown Old Masters Cloudscape muslin produced by
Omni Photographic. Price $165.00.
Retails for $225.00. [They sent me
the wrong color & I'd prefer not to
have to pack it up & return.]

The April field trip to Brookside
Gardens was a spe-cial event in
that is was the last field trip
planned by Joe Razza. The day
was beautiful and several NBCC
members took advantage of the
brilliant display of tulips in all
phases of opening and colors.

Nikon 105 mm F2.5 Manual Focus
lens, used, $135
Nikon 135 mm F2.8 Manual Focus
lens used "bargain" $89.00

===================================

Andrews Annual Open House

Sigma Zoom Wide Angle-Telephoto
28-105mm
f/2.8-4.0
Aspherical
Autofocus Lens for Nikon AF-D Like
New $99
Ross Pierce Tel 301-827-6158
(days), 301-530-7958 (evenings),
email: photoshootermd@yahoo.com

Brookside Flowers

Tom Sullivan

As usual, the Brookside Gardens
staff did a superb job of planting
May, 2004

beautiful arrangements of varieties and color combinations. In
addition to the tulips other bloomers included pansies and hyacinths. There were also some
stragglers of early bloomers; daffodils, jonquils and forsythia.
Those who stayed until the
opening of the conservatory were
treated to a magnificent indoor
spectacular of blooming wonders.

The Andrews Air Force Base Air
Show will take place on May 1516 and will include the Navy Blue
Angels, Canadian Snowbirds jet
demonstration team and the U.S.
Army Golden Knights parachute
demonstration team For information call 301-981-4424.
- 10-

NORTH BETHESDA CAMERA CLUB APPLICATION FOR MEMBERSHIP – 2004-2005
Checks and completed applications from present members must be received by July 15 to assure
membership renewal. Membership will then be opened to those on the waiting list.
PLEASE PRINT LEGIBLY AND FILL IN COMPLETELY even if this is a renewal!
Renewal____New Membership____Date of Application______________Change of Address?________

Name(s)___________________________________Spouse or "Significant Other"_________________
Address_____________________________City____________________State______Zip_________+___
Home Phone (____)___________________E-Mail Address____________________________________
Occupation________________________Employer________________Business Phone (____)________
I AM APPLYING FOR:
Single Membership: $50.00___($25 after 1/1/5___
Family Membership:$90.00___($45 after 1/1/5___

I PLAN TO COMPETE IN:
Black & White: ________
Color Slides: ________
Color Prints:
________
Altered Prints__________
How did you learn about NBCC?___________________________________________________________
Have you ever belonged to/or are currently in another camera club?_______Which one?____________
What traditional Camera equipment do you use? (Make & Model) ______________________________
Do you use a digital camera?_________(Make and Model)______________________________________
Do you have a traditional darkroom? ________Do you have a “digital” darkroom?_______________
IF YOU HAVE A DIGITAL DARKROOM, PLEASE ANSWER THE FOLLOWING QUESTIONS:
Do you use it for printing competition prints?_________________________________________________
Do you use it for manipulation?_____________ for image enhancement?_________________________
Do you use Photoshop in your digital darkroom?______or other similar software?__________________
WOULD YOU BE WILLING TO SERVE ON A COMMITTEE?______________________________
Would you be willing to give a few hours during the year helping with “Community Outreach”?______
If you have suggestions for speakers, fieldtrips, workshops, or other ideas to improve NBCC please
write them on the back!
CHECKS SHOULD BE MADE OUT TO: NORTH BETHESDA CAMERA CLUB.
Please mail to: Ms. Gordie Corbin, 4 Dunwich Manor Place, Gaithersburg, MD 20877
May, 2004
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Back of application form; Please provide any suggestions and/or ideas here.

May, 2004
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North Bethesda Camera Club
39th Annual Awards Dinner
Wednesday, June 2, 2004
6:30 P.M.

Faith United Methodist Church
6810 Montrose Road
Rockville, Maryland
$20.00 per person

Menu
Hors d’oeuvres & punch
Chicken Scarborough
Couscous, green beans
Rolls and salad
Surprise dessert
Coffee and tea
Reservations must be made by Wednesday, May 26
------------------------------------------------------------------------------------------------------------------------------------------------------------Make checks payable to North Bethesda Camera Club
Turn in form and check to Bob Peavy at a club meeting, or
Mail to: Bob Peavy, 4620 North Park Avenue, Apt. 206W, Chevy Chase, MD 20815.

Number of reservations:

Amount enclosed:

@ $20 per person

Names of persons attending as you would like them to appear on the name cards:

May, 2004
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2003 – 2004 Executive Board, Standing, and Special Committees
President
Bob Peavy
Voting Members:
Program
Jim Hawkins
Carol Lee
Barbara DeLouise
Andy Gordon
Bill Richards

Vice President
Sue Oberthaler

Community Outreach
Joel Hoffman
Training Programs
Kent Mason
Carl Root

May, 2004

Treasurer
Chuck Lee

Directors
Jerry Gordon Joel Hoffman
Kent Mason
Jim Hammack
Janet Myder Hammack

Hospitality
Mike Fleming
Beverly Gordon
Bunny Ostrower
Jean Hanson
Lucia Goldman
Mark Segal
Al Goldman
Margaret Colaianni

Membership
Gordie Corbin

Field Trips
Chuck Bress
Dan McDermott
Cezary Raczko

Bold and Italic
Print Competition
Sue Oberthaler
Roy Sewall
Slide Competition
Judy Switt
Jim Hammack

Publicity
Barbara DeLouise
Set-ups
Tom Field
Carl Root
Michael Cline
Cezary Raczko

Secretary
Tom Field

Bulletin Editor
Tom Sullivan
Exhibits
Ross Emerson
Miranda Chin

Webmaster
Tom Sullivan

Church Liaison
Janet Myder Hammack

Club Equipment
Jim Hammack
Tom Field
Judy Switt

Membership Booklet
Gordie Corbin

Gallery
Hans Adler
Print Critiques
Pat and Chuck Bress

Sunshine Committee
Helen Berkson
Print Night Sales
Virginia & Jim Render
Slide Night Sales
Duncan Whitaker

PSA Representative
Janet Myder Hammack

Technical Advisors
Film – Hans Adler
Digital – Sue Oberthaler, Dave
Freeman
Competition Image Review
Joel Hoffman
Judy Switt
Kent Mason
Sue Oberthaler
Awards Dinner Coordinators
Nancy Peavy
José Cartas
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